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Introduction

This VHDL Vital Simulation Guide contains information about
using the Model Technology V-System or ModelSim, Mentor
Graphics QuickHDL, Cadence NC-VHDL, Viewlogic SpeedWave,
and Synopsys VSS to simulate designs for Actel devices. Refer to
the Designer User’s Guide for additional information about using

the Designer software. Refer to the documentation included with
your simulator for information about performing simulation.

Document Organization

The VHDL Vital Simulation Guide contains the following sections:

Chapter 1 - Setup contains information about setting up Model
Technology’s V-System or ModelSim simulator, the Mentor Graphics
QuickHDL simulator, the Cadence Leapfrog simulator, the Viewlogic
SpeedWave simulator, and the Synopsys VSS simulator.

Chapter 2 - Design Flow describes how to use the VHDL design flow
to design an Actel device using Synopsys, or other synthesis-tool software,
and VHDL simulator software.

Chapter 3 - Generating Netlists contains information regarding how
to generate a netlist using Synopsys or other synthesis-tool software.

Chapter 4 - Simulation with ModelSim contains information about
simulating for Actel designs using the Model Technology’s V-System or
ModelSim simulator.

Chapter 5 - Simulation with Cadence NC-VHDL contains
information about simulating for Actel designs using the Cadence NC-
VHDL simulator.

Chapter 6 - Simulation with Innoveda SpeedWave contains
information about simulating for Actel designs using the Viewlogic
SpeedWave simulator.

Chapter 7 - Simulation with Synopsys VSS contains information
about simulating for Actel designs using the Synopsys VSS simulator.



Introduction

Appendix A - Product Support provides information regarding
contacting Actel for customer and technical support.

Document Assumptions

This document assumes the following:
1. You have installed the Designer Series software.
2. You have installed your VHDL VITAL simulator.

3. You are familiar with UNIX workstations and operating systems or
with PCs and Windows operating environments.

4. You are familiar with FPGA architecture and FPGA design software.

Document Conventions

This document uses the following conventions:

Information input by the user follows this format:

keyboard i nput

The contents of a file follows this format:

file contents

This document uses the following variables:

* Actel FPGA family libraries are shown as <act_fam>. Substitute the
desired Actel FPGA family ACT1, ACT2 (for ACT 2 and 1200XL
devices), ACT3, 3200DX, 40MX, 42MX, 545X, 54SX-A, eX, A500K and
APA as needed. For example:

edn2vhdl fam <act _fanm> <desi gn_name>

e Compiled VHDL libraries are shown as <vhd_fam>. Substitute
<vhd_fam> for the desired VHDL family ACT1, ACT2 (for ACT 2 and
1200XL devices), ACT3, A3200DX, A40MX, A42MX, A54SX, A54SX-A,
eX, A500K, or APA as needed. The VHDL language requires that the
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library names begin with an alpha character.

Your Comments

Actel Corporation strives to produce the highest quality online help
and printed documentation. We want to help you learn about our
products, so you can get your work done quickly. We welcome your
feedback about this guide and our online help. Please send your
comments to documentation@actel.com.

Actel Manuals

Online Help

Designer and Libero include printed and online manuals. The online
manuals are in PDF format and available from Libero and Designer’s
Start Menus and on the CD-ROM. From the Start menu choose:

« Programs > Libero > Libero Documentation
* Programs > Designer > Designer Help > Designer Documentation

Also, the online manuals are in PDF format on the CD-ROM in the
“/manuals” directory. These manuals are also installed onto your

system when you install the Designer software. To view the online
manuals, you must install Adobe® Acrobat Reader® from the CD-ROM.

The Designer Series software comes with online help. Online help
specific to each software tool is available in Libero, Designer, ACTgen,
ACTmap, Silicon Expert, Silicon Explorer Il, Silicon Sculptor, and
APSW.






Setup

This chapter contains information on setting up the Model Sim,
Cadence NC-VHDL, Viewlogic SpeedWave, or Synopsys VSS simulator
to simulate Actel designs.

This chapter includes software requirements, steps describing how to
compile Actel FPGA libraries, and other setup information for the
simulation tool you use.

Software Requirements

Migration
Libraries

ModelSim

The information in this guide applies to the Actel Designer Series software
release R1-2003 or later and IEEE-1076-compliant VHDL simulators.
Additionally, this guide contains information about using ModelSim, Cadence
NC-VHDL, Viewlogic SpeedWave, and Synopsys VSS and VeriBest
simulators.

For specific information about which versions this release supports, go
to the Guru automated technical support system on the Actel web site
(http://www.actel.com/guru) and type the following in the Keyword
box:

third party

In addition to the standard Actel libraries, Actel provides a set of
migration libraries. These libraries contain macros supported in 3.1.1ul
and earlier versions of the Designer Series software and macros
possibly needed to retarget designs from a different Actel family. Actel
does not recommend using the migration libraries on new designs.

Use the following procedure to compile libraries for the ModelSim
simulators. Type UNIX commands at the UNIX prompt. Type PC
commands on the command line of the ModelSim Transcript window.
The commands below are for PC. To make the commands work for
UNIX, use forward slashes instead of back slashes.
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This procedure compiles an Actel VITAL library in the
“$SALSDIR\IiIb\vt\95\mti” directory. You must compile the FPGA
library models for the Actel VITAL 95 libraries to work properly.

Note: If there is already an MTI directory in the SALSDIR\Iib\vtI\95
directory, compiled libraries may be present, and you may not
need to perform the following procedure.

1. Create a directory called “mti” in the “$ALSDIR\lib\vtI\95”
directory.

2. Invoke the ModelSim simulator (PC only).

3. Change to the “$ALSDIR\Iib\vtI\95\mti” directory. Type the
following command at the prompt:

cd $ALSDI R\ i b\vtI\95\ nti

4. Create a <vhd_fam> family library directory for your
simulator. Type the following command at the prompt;

vlib <vhd_famp

5. Map the Actel VITAL libray to the <vhd_fam> directory. Type
the following command at the prompt:

vmap <vhd_fam> $ALSDIR Iib\vtI\95\nti\<vhd_fanms

6. Compile your VITAL libraries. You must compile your library entities
before you compile your architectures using the following commands:

vcom -just e -work <famp ../<act_fam vhd>
vcom -just a -work <fane» ../<act_fam vhd>

For example, to compile the 40MX library for your simulator, type the
following commands:

vcom -just e -work <fank ../40nk. vhd

vcom -just a -work <fane» ../40nx.vhd

10



Cadence
NC-VHDL

Software Requirements

7. (Optional) Compile the migration library. Only perform this step
if you are using the migration library. Type the following command at the
prompt:
vcom -wor k <vhd_fam> ..\<act_fam>_nm g.vhd

Use the following procedure to compile libraries for the Cadence

NC-VHDL simulator (UNIX only). This procedure compiles an Actel VITAL
library in the “$ALSDIR/lib/vtl/95/ncvhdl” directory. You must compile the
FPGA library models for the Actel VITAL 95 libraries to work properly.

1. Createadirectory called “ncvhdl” in the “$ALSDIR/lib/vtl/95”
directory.

2. Change to the “$ALSDIR/lib/vtl/95/ncvhdl” directory.
Create a directory named <vhd_fam>.

4. Map the library. Compile the models and create the “cds.lib” file as
follows:

I NCLUDE $CDS/tools/inca/files/cds.lib
DEFI NE <vhd_fanm> $ALSDI R/ |i b/ vtl/95/ ncvhdl/ <vhd_f ane

5. Compile the library. Type the following command at the prompt;

ncvhdl -work <vhd_fank -nmessages $ALSDI R/ |ib/vtl/95/
<act _fanp. vhd

For example, to compile the 40MX library for your simulator, type the
following command:

ncvhdl -work a40nx -nessages $ALSDI R/ 1ib/vtl/95/40nk. vhd

6. (Optional) Compile the migration library. Only perform this step
if you are using the migration library. Type the following command at the
prompt:

ncvhdl -work <vhd_fan» -nmessages $ALSDI R/ 1ib/vtl/95/
<act _fanmp_ni g. vhd

11
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Viewlogic
SpeedWave
(PC)
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Use the following procedure to compile Actel VITAL libraries for the
Viewlogic SpeedWave simulator (PC only).

During the installation of the SpeedWave simulator, you can choose to
install the Synopsys IEEE library or the Vantage IEEE library. You need
the Synopsys library for compatibility with the Actel VITAL libraries.
The Synopsys library is a superset of the Vantage library.

1.

10.

Create a directory called “swave” in the “c:\actel\lib\vtI\95”
directory.

Set your project directory. Invoke Project Manager and click the
New button. Enter “swave” in the Project Name box and
“c:\actel\lib\vtI\95\swave” in the Project Directory box. Click the
Next button three times, then click the Finish button to complete the
process. Do not set your library search order.

Save your project and exit Project Manager.
Invoke SpeedWave.

Open the HDL Library Manager window. Choose the Analyze
VHDL Design command from the File menu. Click Cancel in the
Welcome dialog box. The HDL Manager window is displayed.

Create a <vhd_fam> library. Choose the Create command from
the Library menu. Specify “c:\actel\lib\vtI\95\swave” in the Library
Path box and <vhd_fam> in the Symbolic Name box. Click OK.

Add system libraries to search order. Make sure that the
“SYNOPSYS.LIB” and “IEEE.LIB” libraries are listed under the
VHDL System Libraries section in the VHDL View window.

Add the Actel VITAL library to the <vhd_fam> library. Choose
the Add Source Files command from the Library menu. Select the
<act_fam=>.vhd file from the “c:\actel\lib\vt\95\” directory. Click

OK.

Compile the Actel VITAL library. Select the <act_fam>.vhd file in
the VHDL View section of the HDL Manager window. Choose the
Analyze Source File command from the Analyze menu.

(Optional) Add the Actel VITAL Migration library to the
<vhd_fam> library. Select the <act_fam>_mig.vhd file from the
“c:\actel\lib\vtI\95\" directory. Click OK.



Viewlogic
SpeedWave
(UNIX)

Software Requirements

11. (Optional) Compile the Actel VITAL Migration library. Only
perform this step if you are using the migration library. Select the
<act_fam>_mig.vhd file in the VHDL View section of the HDL
Manager window. Choose the Analyze Source File command from
the Analyze menu.

Use the following procedure to compile libraries for Viewlogic's
SpeedWave simulator. This procedure compiles an Actel VITAL library
in the “$ALSDIR/lib/vtl/95/swave” directory. You must compile the
FPGA library models for the Actel VITAL 95 libraries to work properly.

During the installation of the SpeedWave simulator, you can choose to
install the Synopsys IEEE library or the Vantage IEEE library. The
Synopsys library is a superset of the Vantage library and you need to
use it with the Actel VITAL libraries.

The following procedures use the Vantage IEEE library. To use the
Synopsys IEEE library, use the “-lib $VANTAGE_VSS/pgm/libs/
synopsys.lib” switch in the “analyze” and “simulation” commands
described below.

1. Create a “swave” directory in the “$ALSDIR/lib/vtl/95”
directory.

2. Change to the “$ALSDIR/lib/vtl/95/swave” directory.

3. Create and map a library directory for your simulator. Type
the following command at the prompt:

vanlibcreate $ALSDI R/ |ib/vtl/ 95/ swave/ <vhd_f an> <vhd_f anmr

4. Compile the library. Type the following command at the prompt:

analyze -src ../<act_fanp.vhd -1ib <vhd_fan» -libieee -lib
$VANTAGE_VSS/ pgn | i b/ synopsys. lib

For example, to compile the 40MX library for your simulator, type
the following command:

analyze -src ../40mx.vhd -lib a40nmx -libieee -lib
$VANTAGE_VSS/ pgnt | i b/ synopsys. lib

13
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Synopsys VSS
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(Optional) Compile the migration library models. Type the
following command at the prompt:

analyze -src ../<act_fanp_mig.vhd -lib <vhd_fanm> -1ibi eee
-lib $VANTAGE VSS/ pgni|lib/synopsys.lib

Use the following procedures to compile libraries for the Synopsys VSS
simulator (UNIX). This procedure compiles an Actel VITAL library in
the “$ALSDIR/lib/vtl/95/vss” directory. You must compile the VITAL
library models prior to using them to simulate.

1.
2.

Create a “vss” directory in the “$ALSDIR/lib/vtl/95” directory.

Create a <vhd_fam> directory in the “$ALSDIR/lib/vtl/95/vss”
directory.

Using a text editor, create a “.synopsys_vss.setup” file in the
“$ALSDIR/lib/vtl/95/vss” directory. Type the following
command at the prompt:

<vhd_fanmp: ./<vhd_fanme
default: ./<vhd_fanr

Change to the “$ALSDIR/lib/vtl/95/vss” directory and
compile the library. Type the following command at the prompt;

cd SALSDIR/ lib/vtl/95/vss
vhdl an -w <vhd_fanm> $ALSDI R/ |i b/ vt/ 95/ <act _fan®. vhd

For example, to change to the “$ALSDIR/lib/vtl/95/vss” directory
and compile the 40MX library for your simulator, type the following
command:

cd $ALSDIR/1ib/vtl/95/vss
vhdl an -w a40nx $ALSDI R/ | i b/ vtl/ 95/ 40nmx. vhd
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5. (Optional) Change to the “$ALSDIR/lib/vtl/95/vss” directory
and compile the migration library. Only perform this step if you

are using the migration library. Type the following command at the
prompt:

cd $ALSDIR/lib/vtl/95/vss
vhdl an -w <vhd_fanm> $ALSDI R/ |i b/ vtl/ 95/ <act _fan>_mi g.vhd

6. Check for any warning or error messages.

Project Setup for Viewlogic SpeedWave (PC Only)

You must set up an Actel project in the Viewlogic Project Manager for
each Actel design before creating your design in Viewlogic. The
following procedures describe the process.

1. Invoke Project Manager.

2. Set up a new project. Choose the New command from the File
menu. The Creating a New Project wizard is displayed.

3. Set the Project Directory. Type the full path name of your design
directory in the Project Directory box or use the Browse button.
Type the name of your project in the Project Name box. Click the
Next button.

4. Locate your project file. Type the full path name of your project
file in the Location of Project File box or use the Browse button.
Click the Next button.

15
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5. Select an Actel FPGA library. Choose a library in the Configured
FPGA Libraries box. Click the icon of the Actel library you want to
select, then click Next.

Creating a new project

FPGA libraries are supplied through VYiswlogic's parthers.
Yiou can set pour project to include any FPGA companent
libraries that have already been configured.

Configured FPGA Libraries:

~ji; 32000x
i o

A

If you want, pick an & 42 |
FPGA component @ B454 J
library From the right. it B4SHh |

DeSelect |

< Back | Nest » | Cancel | Help

Figure 1-1. FPGA Libraries dialog box

6. (Optional) Add additional libraries. Click the Add button and
type the full path name of the library you want to add. Or, use the
Browse button.

7. Save the project. Choose the Save command from the File menu.

Creating a If you use SpeedWave to simulate your designs, you must create a

Project Library project library in SpeedWave, in addition to creating an Actel project in

in SpeedWave Project Manager, for each VHDL synthesis-based Actel project. The
following procedures describe the process.

1. Invoke SpeedWave.

2. Open the HDL Manager window. Choose the Analyze VHDL
Design command from the File menu. Click Cancel in the Welcome
dialog box. The HDL Manager window is displayed.

16
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Set up a project. Choose the Create command from the Library
menu. The Create Library dialog box is displayed. Make sure the
path in the Library Path box is correct and already exists. Type
“user” in the Symbolic Name box and click OK. Make sure the
Output window reports no errors.

Verify that the “user” library icon appears under the VHDL
User Libraries section in the VHDL View window.

Add the compiled Actel VITAL library to the Project Libraries.
Choose the Add to Workspace command from the Library menu.

The Add Existing Library to Workspace dialog box is displayed.

Click the ellipsis box to open the Select Directory dialog box.

Browse to the “c:\actel\lib\vt\95\swave\<vhd_fam>.lib” directory
and click OK. Click OK again in the Add Existing Library to

Workspace dialog box. If you have not compiled the Actel VITAL

library, go to “Viewlogic SpeedWave (PC)” on page 12 for the procedure.

Note: Only add the <vhd_fam=>.lib if you have referenced Actel
macros in your VHDL netlist.

Add system libraries to the Project Libraries. Make sure the
“SYNOPSYS.LIB” and “IEEE.LIB” libraries are listed under VHDL
System Libraries in the VHDL View window. If they are not present,
you must reinstall SpeedWave, making sure to choose the Synopsys
IEEE libraries when prompted.

Save the project workspace. Choose the Save command from the
File menu.

17






Design Flow

This chapter describes the design flow for simulating Actel designs
with a VHDL VITAL-compliant simulation tool.

VHDL VITAL Design Flow lllustrated

Figure 2-1 shows the design flow for an Actel FPGA using Designer software
and a VITAL-compliant VHDL simulator?.

Design Creation/Verification N
Behavioral % Standard
VHDL VHDL
Testbench

| +
Synthesis Tool

VHDL Synthesis Behavioral/Structural/Timing
Simulation
---» | edn2vhd| F--» |Structural||---
| - - VHDL
o Netlist Translation Netlist
N i (Optional)
EDIF [ ___
Netlist i
Design Implementation
I Structural SDF
I VHDL File
Netlist
Export Command ‘ ]
‘V in File Menu
o ! 1 el ]
~ User Tools
Compile Layout Fuse ‘ ‘

il a”E“Im@” @ ©F=
X —> >
J l o e Back
PinEdit ChipEdit Timer Annotate
(for ASOOK devices) N

Fuse
File
Programming
— BP Microsystems
SI|IQ?n ScuI[?tor ‘ ‘
(Antifuse Families) ’ Flash Pro ‘
(Flash Families)
d Actel i
Device
System Verification Soooo”

Silicon Explorer Il

Figure 2-1. Actel-VHDL Design Flow

1. The grey boxes in Figure 2-1 denote Actel-specific utilities/tools.
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Chapter 2: Design Flow

VHDL VITAL Design Flow Described

The Actel VHDL VITAL design flow has four main steps:
1. Design Creation/Verification

2. Design Implementation

3. Programming

4.  System Verification

The following sections detail these steps.

Design During design creation/verification, a design is captured in an RTL-
Creation/ level (behavioral) VHDL source file. After capturing the design, you
Verification can perform a behavioral simulation of the VHDL file to verify that the

VHDL code is correct. The code is then synthesized into an Actel gate-

level (structural) VHDL netlist. After synthesis, you can perform an

optional pre-layout structural simulation of the design. Finally, an EDIF netlist
is generated for use in Designer and a VHDL structural post-layout netlist is
generated for timing simulation in a VHDL VITAL-compliant simulator.

VHDL Source Entry

Enter your VHDL design source using a text editor or a context-sensitive
HDL editor. Your VHDL design source can contain RTL-level
constructs, as well as instantiations of structural elements, such as
ACTgen macros.

Behavioral Simulation

Perform a behavioral simulation of your design before synthesis.
Behavioral simulation verifies the functionality of your VHDL code.
Typically, you use zero delays and a standard VHDL test bench to

drive simulation. Refer to the documentation included with your
simulation tool for information about performing functional simulation.

Synthesis

After you have created your behavioral VHDL design source, you must
synthesize it. Synthesis transforms the behavioral VHDL file into a gate-
level netlist and optimizes the design for a target technology. The

20
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Implementation

VHDL VITAL Design Flow Described

documentation included with your synthsis tool contains information
about performing design synthesis.

EDIF Netlist Generation

After you have created, synthesized, and verified your design, you must
generate an Actel EDIF netlist for place-and-route in Designer.

This EDIF netlist is also used to generate a structural VHDL netlist for use
in structural simulation.

Structural VHDL Netlist Generation

Generate a gate-level VHDL netlist from your EDIF netlist for use in post-
synthesis pre-layout structural simulation by either exporting it from Designer
or by using the Actel “edn2vhdl” program.

Structural Simulation

Perform a structural simulation before placing-and-routing. Structural
simulation verifies the functionality of your post-synthesis pre-layout structural
VHDL netlist. Unit delays included in the compiled Actel VITAL libraries are
used. Refer to the documentation included with your simulation tool for
information about performing structural simulation.

During design implementation, you place-and-route a design using
Designer. Additionally, you may perform timing analysis on a design in
Designer with the Timer tool. After place-and-route, perform
postlayout (timing) simulation with a VHDL VITAL-compliant
simulator.

Place-and-Route

Use Designer to place-and-route your design. Refer to the Designer User’s
Guide for information about using Designer.

Timing Analysis

Use the Timer tool in Designer to perform static-timing analysis on
your design. Refer to the Timer User’s Guide for information about using
Timer.

21
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Programming

System
Verification
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Timing Simulation

Perform a timing simulation on your design after placing-and-routing
it. Timing simulation verifies that the design meets your timing
constraints.

Program a device with programming software and hardware from Actel or
a supported third-party programming system. Refer to the Designer User’s
Guide and the Activator and APS Programming System Installation and

User’s Guide or Silicon Sculptor User’s Guide for information about
programming an Actel device.

You can perform system verification on a programmed device using
the Actel Silicon Explorer diagnostic tool. Refer to the Activator and
APS Programming System Installation and User’s Guide or Silicon

Explorer Quick Start for information about using the Silicon Explorer.



Generating Netlists

This chapter describes the procedures for generating EDIF and
structural VHDL netlists.

Generating an EDIF Netlist

After capturing your schematic or synthesizing your design, generate
an EDIF netlist from your schematic capture or synthesis tool. Use the
EDIF netlist for placing-and-routing in Designer. Refer to the
documentation included with your schematic capture or synthesis tool
for information about generating an EDIF netlist.

Generating a Structural VHDL Netlist

You can generate a structural VHDL netlist using Designer or the
“edn2vhdIl” program. Use the structural VHDL netlist for structural and
timing simulation.

To generate a structural netlist using Designer,

1.
2.

Invoke Designer.

Importthe EDIF netlist. Choose the Import Source File command from
the File menu. This displays the Import Source dialog box. . Type the full
path name of your EDIF netlist or use the Browse button to select your
design. Click OK. In the EDIF Import Options dialog box, specify Generic
as the EDIF flavor.

Exportastructural VHDL netlist. From the File menu, choose Export,
then Netlist. This displays the Export Netlist Files dialog box. In the Export
Netlist Files dialog box, specify the File name and set the Save As type to
VHDL. Click OK.

23
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To generate a structural netlist using “edn2vhdl,”
1. Change to the directory that contains the VHDL design files.
2. Type the following command at the UNIX or DOS prompt:

edn2vhdl FAM {<act_famp} [ EDNIN: <Edif_Filel>[ +<Edif_File2...>] ][ VHDOUT: <Vhdl _File> ]<desi gn_nane>

24

The “EDNIN” option specifies the EDIF input file(s). You can specify
multiple files with the “+” delimiter between file names. The default EDIF
input file is <design_name>.edn. The “VHDOUT” option specifies the
VHDL output file names. The default VHDL output file is
<design_name=>.vhd.



Simulation with ModelSim

This chapter describes steps to perform Functional (Behavioral and
Structural) and Timing simulation for Actel devices using the ModelSim
simulator.

The procedures shown are for PC. The same setup procedures work
similarly for UNIX. Use forward slashes in place of back slashes. For
PC, type commands into the MTI window. For UNIX, type commands
into a UNIX window.

Behavioral Simulation

Use the following procedure to perform a behavioral simulation of a
design. Refer to the documentation included with your simulation tool
for additional information about performing behavioral simulation.

1. Invoke your ModelSim simulator. (PC only)

2. Change directory to your project directory. This directory must
include your VHDL design files and testbench. Type:

cd <project_dir>
3. Map to the Actel Library. If any Actel macros are instantiated in

your VHDL source, type the following command to map them to
the compiled Actel VITAL library.

vmap <vhd_fam> $ALSDIR Iib\vtI\95\nti\<vhd_fans

To reference the Actel family library in your VHDL design files, add
the following lines to your VHDL design files:

library <vhd_fanp;
use <vhd_fanp. conmponents. al | ;

4. Create a “work” directory. Type:

vlib work

5. Map to the “work” directory. Type the following command:

25



Chapter 4: Simulation with ModelSim

26

vmap work .\ work

Perform a behavioral simulation of your design. To perform a
behavioral simulation using your V-System or ModelSim simulator,
compile your VHDL design and testbench files and run a

simulation. For hierarchical designs, compile the lower-level design
blocks before the higher-level design blocks.

The following commands demonstrate how to compile VHDL
design and testbench files:

vcom - 93<behavi or al >. vhd
vcom - 93<t est _bench>. vhd
To simulate the design, type:

vsi m <confi gurati on_name>

For example:

vsi m test _adder _behave

The entity-architecture pair specified by the configuration named
test_adder_behave in the testbench will be simulated.



Structural Simulation

Structural Simulation

Use the following procedure to perform structural simulation.

1.

Generate a structural VHDL netlist.

If you are using Synopsys Design Compiler, generate a structural
VHDL netlist using this tool.

If you are using other synthesis tools, generate a gate-level VHDL
from your EDIF netlist by either exporting it from Designer or by
using the edn2vhdl program.

To generate a structural netlist using “edn2vhdl,”

2.
3.

Change to the directory that contains the VHDL design files.
Type the following command at the UNIX or DOS prompt:

edn2vhdl FAM {<act_fanp} [ EDNIN: <Edif_Filel>[ +<Edif_File2...>] ][ VHDOUT: <Vhdl _File> ]<desi gn_nane>

The “EDNIN” option specifies the EDIF input file(s). You can specify
multiple files with the “+” delimiter between file names. The default EDIF
input file is <design_name=>.edn. The “VHDOUT” option specifies the
VHDL output file names. The default VHDL output file is
<design_name>.vhd.

To generate a netlist using Designer Series software,

4,

Exportastructural VHDL netlist. From the File menu, choose Export,
then Netlist. This displays the Export Netlist Files dialog box. In the Export
Netlist Files dialog box, specify the File name and set the Save As type to
VHDL. Click OK.

Note: The VHDL generated by both Designer and the edn2vhdl program
will use std_logic for all ports. The bus ports will be in the same bit
order as they appear in the EDIF netlist.

Map tothe Actel VITAL library. Run the following command to map the
compiled Actel VITAL library.

vmap <vhd_fanm> $ALSDI R i b\vtI\95\ nti\<vhd_fan®
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Compile the structural netlist. Compile your VHDL design and
testbench files. The following commands demonstrate how to compile
VHDL design and testbench files:

vcom - 93<structural >. vhd -just e
vcom -93<structural >. vhd -just a
vcom <t est _bench>. vhd

Note: First, the application compiles the entities. Then, it compiles
the architectures, as required for VHDL netlists written by
some tools.

Run the structural simulation. To simulate your design, type:

vsi m <confi gurati on_name>

For example;

vsi mtest_adder_structure

The entity-architecture pair specified by the configuration named
test_adder_structure in the testbench will be simulated.

Timing Simulation

Use the following procedure to perform timing simulation.
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1.

Place-and-route your design in Designer. Refer to the Designer
User’s Guide for information about using Designer.

Extract timing information for your design. From the File
menu, click Export. Then, click Timing Files. Choose SDF and click
Save (or click Back Annotate). The Back Annotate dialog box is
displayed. Create a <design_name>.sdf file by specifying SDF as the
CAE type. Click OK.

Compile the structural netlist. To perform a timing simulation
using your V-System or ModelSim simulator, compile your VHDL
design and testbench files, if they have not already been compiled
for a structural simulation, and run a simulation. The following
commands demonstrate how to compile VHDL design and
testbench files:



Timing Simulation

vcom <structural >. vhd -just e
vcom <structural >. vhd -just a
vcom <t est _bench>. vhd

Note: Performing the previous steps compiles the entities first and
then the architectures, as required for VHDL netlists written
by some tools.

Run the back-annotation simulation using the timing
information in the SDF file. Type:

vsi m -sdf [ max| typ| mi n] /<regi on>=<desi gn nanme>.sdf -c
<confi guration_nane>

The <region> option specifies the region (or path) to an instance in
a design where back annotation begins. You can use it to specify a
particular FPGA instance in a larger system design or testbench that
you wish to back annotate. For example:

vsi m - sdf max /uut =adder.sdf -c test_adder_structural

In this example, the entity “adder” has been instantiated as instance
“uut” in the testbench. The entity-architecture pair specified by the
configuration named “test_adder_structural” in the testbench will be
simulated using the maximum delays specified in the SDF file.
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Simulation with Cadence NC-VHDL

This chapter describes steps to perform Functional (Behavioral and
Structural) and Timing simulation for Actel devices using the Cadence
NC-VHDL simulator.

Behavioral Simulation

After you have coded the VHDL descriptions of the logic blocks, test
and debug the design using the NC-VHDL simulator. Use the following
procedure to perform behavioral simulation.

1.

Create a work directory and a cds.lib file in the project
directory. At the UNIX prompt, type:

nkdi r work

Using a text editor, create a cds.lib file and enter the following
lines:

| NCLUDE $CDS/tool s/inca/files/cds.lib

Map to the Actel VITAL library. If any Actel macros are
instantiated in your VHDL source, add the following lines to your
cds.lib file to map them to the compiled Actel VITAL library.

DEFI NE <vhd_fam> $ALSDI R/ |i b/ vt1/95/ ncvhdl / <vhd_f anm>
DEFI NE WORK . / wor k

Add the following lines to your VHDL design files to reference the
Actel Family library in your VHDL design files:

library <vhd_fanp;
use <vhd_fanp. conponents. al |

Compile the VHDL design and testbench files. Type:

ncvhdl -work work -nessages <behavi oral >. vhd
ncvhdl -work work -nessages <test_bench>. vhd

Elaborate the design. Type the following commands at the
prompt;

ncel ab -work work -nessages <configuration_nane>
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In the above, <configuration_name> is the name of the
configuration in the testbench.

For example

ncel ab -work work -messages test_add_behave

The entity-architecture pair specified by the configuration named
test_adder_behave in the testbench will be elaborated.

Simulate the design. Type the following command at the prompt;

ncsim-batch -run <configurati on_nanme>

In the above, <configuration_name> is the name of the
configuration in the testbench.

For example:

ncsim-batch -run test_add_behave

Structural Simulation

Use the following procedure to perform structural simulation.
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1.

Map to the Actel VITAL library. Create a cds.lib file in the project
directory as follows:

| NCLUDE $CDS/tool s/incal/files/cds.lib
DEFI NE <vhd_fanm> $ALSDI R/ |i b/ vtl/95/ ncvhdl / <vhd_f anmr
DEFI NE WORK . / wor k

Compile the structural netlist. Compile your VHDL design and
testbench files. If you have not already generated a structural netlist,

go to “Generating a Structural VHDL Netlist” on page 23. The following
commands demon